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Предисловие редактора

Более двадцати лет назад, ещё в прошлом тысячелетии, в далёкой, далёкой, почти 
сказочной Новой Зеландии два статистика Джентельмен и Айхэка из Оклендского 
университета породили ещё один язык программирования. Немного подумали 
и назвали его R. 

С тех пор, для того, чтобы вы могли легко и непринуждённо посчитать медиа-
ну, построить линейную модель, найти кластеры или, страшно подумать, размно-
жить ваш набор данных для целей бутстрэпа, десятки, а возможно, и сотни тысяч 
квалифицированных и разных любителей статистической обработки данных по-
ложили на алтарь с буквой R самое ценное. Да, да – своё время! Пользуйтесь этой 
программой с уважением.

Когда мы (группа едва знакомых по интернету) чуть больше десяти лет назад 
начали цикл статей «Анализ данных с R» в ещё живой и бумажный журнал Linux 
Format, никакой печатной продукции, да и вообще хоть сколько-нибудь исчер-
пывающей информации на русскоязычном пространстве по этой теме просто не 
было. Хотя во всём остальном мире статистики R захватывал университет за уни-
верситетом. Чуть позже благодаря усилиям лидера группы биолога Алексея Ши-
пунова из этого цикла родилась первая значительная (мы честно на тот момент 
так думали) R-книга на русском языке «Наглядная статистика. Используем R!», 
выпущенная издательством «ДМК Пресс» в 2012 году и находящаяся сейчас в от-
крытом доступе на CRAN для всех желающих.

Поэтому отрадно сейчас видеть, что мировая литература в области R-анализа 
уже достаточно регулярно, хоть и с задержкой, добирается до наших краёв. R – 
это просто. По сути, сборник рецептов является самым замечательным форма-
том для его практического применения. Другое дело – сам сборник рецептов – 
это только начало, потому что возможности R безграничны! В области обработки 
статистики, естественно.

Евгений Балдин, к. ф.-м. н.



Добро пожаловать 
в книгу рецептов R

Язык R представляет собой мощный инструмент для статистики, графики и ста-
тистического программирования. Он ежедневно используется десятками тысяч 
людей для проведения серьезного статистического анализа. Это бесплатная си-
стема с открытым исходным кодом, реализация которой является коллективным 
достижением большого числа умных, трудолюбивых людей. Для этого языка су-
ществует свыше 10 000 доступных пакетов дополнений. R является серьезным 
конкурентом всех коммерческих пакетов для статической обработки данных.

Но R может расстраивать, и может быть не ясно, как выполнить множество за-
дач, даже простых. Простые задачи становятся легкими, когда вы знаете, как это 
сделать, но при этом понимаете, что это слово «как» может свести с ума.

Эта книга полна практических рецептов, каждый из которых решает опреде-
ленную проблему. Каждый рецепт включает в себя краткое введение в решение, 
а  затем обсуждение, целью которого является объяснить решение и  дать вам 
представление относительно того, как оно работает. Мы знаем, что эти рецепты 
полезны, и знаем, что они работают, потому что сами используем их.

Диапазон рецептов обширен. Он начинается с основных задач, а затем перехо-
дит к вводу и выводу, общей статистике, графике и линейной регрессии. Любая зна-
чительная работа с R будет включать в себя большинство этих областей или их все.

Если вы новичок, то эта книга поможет вам быстрее сориентироваться. Если 
вы промежуточный пользователь, эта книга будет полезна, чтобы расширить ваш 
кругозор и покопаться в памяти («Как снова выполнить этот тест Колмогорова–
Смирнова?»).

Данная книга не является учебником по языку R, хотя вы и узнаете что-то, 
изучая рецепты. Это не справочное руководство, но в ней содержится много по-
лезной информации. Это не книга по программированию на R, хотя многие ре-
цепты полезны в сценариях, написанных на этом языке.

Наконец, эта книга не является введением в статистику. Многие рецепты пред-
полагают, что вы знакомы с  базовой статистической процедурой, если таковая 
имеется, и просто хотите знать, как это делается в R.

Рецепты
В большинстве рецептов используется одна или две функции R для решения 
конкретной задачи. Важно помнить, что мы не описываем функции подробно; 
скорее, мы приводим достаточно описания, чтобы решить насущную пробле-
му. Почти каждая такая функция имеет дополнительные возможности, помимо 
описанных здесь, а некоторые из них обладают удивительными возможностями. 



Мы настоятельно рекомендуем вам прочитать страницы справки по функциям. 
Скорее всего, вы узнаете что-нибудь ценное.

Каждый рецепт предлагает один из способов решения конкретной задачи. Ко-
нечно, для каждой задачи существует несколько разумных решений. Когда нам 
было известно несколько вариантов решения, мы обычно выбирали самое прос
тое. Для любой задачи вы, вероятно, сможете найти несколько альтернативных 
решений самостоятельно. Это книга рецептов, а не Библия.

В частности, R имеет буквально тысячи дополнительных пакетов, доступных 
для скачивания, многие из которых реализуют альтернативные алгоритмы и ста-
тистические методы. Эта книга концентрируется на основных функциях, доступ-
ных через базовый дистрибутив, в сочетании с несколькими важными пакетами, 
известными под общим названием tidyverse.

Наиболее краткое определение этого термина дает Хэдли Уикхем (https://blog.
rstudio.com/2016/09/15/tidyverse-1-0-0/), его создатель и один из его основных раз-
работчиков:

Tidyverse – это набор пакетов, которые работают в гармонии, потому что они имеют 
общие представления данных и дизайн API. Пакет tidyverse разработан, чтобы упрос
тить установку и загрузку основных пакетов из tidyverse одной командой. Лучшее мес
то, чтобы познакомиться со всеми пакетами в tidyverse и их совместимостью, – это 
книга R for Data Science (https://r4ds.had.co.nz). 

Примечание относительно терминологии 
Цель каждого рецепта – решить задачу и сделать это быстро. Вместо того чтобы 
работать в утомительной прозе, мы иногда упорядочиваем описание с помощью 
терминологии, которая является правильной, но не точной. В качестве неплохо-
го примера можно привести термин обобщенная функция. Мы называем print(x) 
и plot(x) обобщенными функциями, потому что они работают для многих видов 
x, соответственно обрабатывая каждый вид. Специалист, работающий в области 
теории вычислительных машин и систем, вздрогнет при виде нашей термино-
логии, потому что, строго говоря, это не  просто «функции»; это полиморфные 
методы с динамической диспетчеризацией. Но если бы мы тщательно расшиф-
ровывали все эти подробности, основные решения были бы погребены под тех-
ническими деталями. Поэтому мы называем их просто функциями, что, как нам 
кажется, более читабельно.

Еще один пример, взятый из статистики, – это сложность, связанная с семан-
тикой проверки статистических гипотез. Использование строгого языка теории 
вероятностей затруднит практическое применение некоторых тестов, поэтому мы 
используем более разговорный язык при описании всех статистических тестов. См. 
введение к главе 9 для получения дополнительной информации о том, как провер-
ка гипотез представлена в рецептах.

Наша цель состоит в том, чтобы сделать мощь языка R доступной для широкой 
аудитории, сделав книгу читабельной, а не формальной. Мы надеемся, что экс-
перты в соответствующих областях поймут, является ли наша терминология не-
формальной.
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Примечания по программному обеспечению и платформам
Базовый дистрибутив R имеет частые и  запланированные выпуски, но опреде-
ление языка и реализация ядра стабильны. Рецепты, приведенные в этой книге, 
должны работать с любым последним выпуском базового дистрибутива.

Некоторые рецепты имеют специфические для платформы соображения, и мы 
тщательно их отметили. Эти рецепты в основном касаются проблем, связанных 
с программным обеспечением, таких как установка и настройка. Насколько нам 
известно, все остальные рецепты будут работать на всех трех основных платфор-
мах для R: Windows, macOS и Linux/Unix.

Дополнительные источники
Ниже приводится ряд советов для получения дополнительной информации.

В сети
Своего рода «основа» для всего, что связано с  R, – сайт проекта R (https://
www.r-project.org). Отсюда вы можете скачать R для своей платформы, допол-
нительные пакеты, документацию и исходный код, а также множество других 
ресурсов.
Помимо сайта проекта R, мы рекомендуем использовать R-поисковик, например 
RSeek (https://rseek.org), созданный Сашей Гудманом. Вы можете использовать 
общую поисковую систему, такую как Google, но при применении «R» в качест
ве поискового запроса выдается слишком много посторонних вещей. См.  ре-
цепт 1.11 для получения дополнительной информации о поиске в интернете.
Чтение блогов – отличный способ узнать о R и быть в курсе самых передо-
вых разработок. Таких блогов на удивление много, поэтому мы рекомендуем 
два из них: R-bloggers (https://www.r-bloggers.com), созданный Талом Галили, 
и PlanetR (http://planetr.stderr.org). Подписавшись на их RSS-каналы, вы будете 
получать уведомления об интересных и полезных статьях с десятков сайтов.

Книги
Есть много, много книг об обучении и использовании R. Перечисленные здесь 
несколько изданий мы нашли полезными. Обратите внимание, что сайт про-
екта R содержит обширную библиографию книг, связанных с R (https://www.r-
project.org/doc/bib/R-books.html). 
R for Data Science (http://shop.oreilly.com/product/0636920034407.do) Хэдли Уикхэ-
ма и Гарретта Гроулмунда (издательство O’Reilly) – отличное введение в паке-
ты tidyverse, особенно в том, что касается их использования в анализе данных 
и статистике. Данное издание также доступно онлайн (https://r4ds.had.co.nz). 
Мы полагаем, что книга R Graphics Cookbook (http://shop.oreilly.com/
product/0636920063704.do) Уинстона Чанга (издательство O’Reilly) незаменима 
для создания графики. Книга ggplot2: Elegant Graphics for Data Analysis Хэдли 
Уикхэма (издательство Springer) представляет собой наиболее полный спра-
вочник по графическому пакету ggplot2, который мы используем в этой книге.
Любому, кто занимается серьезной графикой в ​​R, понадобится книга R Graph-
ics Пола Мёррелла (издательство Chapman & Hall / CRC).
R in a Nutshell (http://shop.oreilly.com/product/9780596801717.do) Джозефа Адлера 
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(издательство O’Reilly) – это краткое руководство и справочник, который всегда бу-
дет рядом с вами. Оно охватывает гораздо больше тем, нежели эта книга рецептов.
Новые книги по  программированию на  языке R появляются регулярно. Мы 
предлагаем Hands On Programming with R (https://www.oreilly.com/library/view/
hands-on-programming-with/9781449359089/) Гарретта Гроулмунда (издательство 
O’Reilly) для введения или The Art of R Programming Нормала Мэтлоффа (изда-
тельство No Starch Press). Advanced R Хэдли Уикхэма (издательство Chapman & 
Hall / CRC) доступна в печатном виде, а также бесплатно на странице http://adv-r.
had.co.nz. В ней еще более подробно представлены продвинутые темы R. Efficient 
R Programming (http://shop.oreilly.com/product/0636920047995.do) Колина Гиллес
пи и Робина Ловеласа (издательство O’Reilly) – еще одно хорошее руководство 
для изучения более глубоких концепций программирования на языке R.
Modern Applied Statistics with S, 4-е изд., Уильяма Венейблса и Брайана Рипли 
(Springer) использует R для иллюстрации множества передовых статистиче-
ских методов. Функции и наборы данных книги доступны в пакете MASS, ко-
торый входит в стандартный дистрибутив R.
Серьезные фанаты могут скачать R Language Definition (https://cran.r-project.org/
doc/manuals/R-lang.pdf) от R Core Team. R Language Definition находится в стадии 
разработки, но может ответить на многие ваши подробные вопросы о R как 
о языке программирования.

Книги по статистике 
Для изучения статистики прекрасно подойдет Using R for Introductory Statistics 
Джона Верзани (издательство Chapman & Hall / CRC). Эта книга обучает статис
тике и R, давая необходимые навыки работы с компьютером для применения 
статистических методов.
Вам понадобится хороший учебник по  статистике или справочник, чтобы 
точно интерпретировать статистические тесты, выполненные в R. Подобных 
хороших книг множество – их слишком много, чтобы можно было рекомендо-
вать какую-либо одну.
Авторы книг по  статистике все чаще используют R для иллюстрации своих 
методов. Если вы работаете в специализированной области, то, вероятно, най-
дете полезную и актуальную книгу в библиографии проекта R (https://www.r-
project.org/doc/bib/R-books.html). 

Условные обозначения и соглашения, принятые в книге 
В книге используются следующие типографские соглашения.

Курсив используется для смыслового выделения новых терминов, адресов 
электронной почты, а также имен и расширений файлов.

Моноширинный шрифт применяется для листингов программ, а также в  обычном 
тексте для обозначения имен переменных, функций, типов, объектов, баз данных, 
переменных среды, операторов и ключевых слов.

Моноширинный полужирный шрифт используется для обозначения команд или фраг-
ментов текста, которые пользователь должен ввести дословно без изменений.

Моноширинный курсив – для обозначения в исходном коде или в командах шаблон-
ных меток-заполнителей, которые должны быть заменены соответствующими 
контексту реальными значениями.
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Этот элемент означает подсказку или предложение.

 

	

Этот элемент означает общее примечание.

	

Этот элемент указывает на предупреждение или предостережение.

Использование примеров кода
Дополнительный материал (примеры кода, исходный код, упражнения и т. д.) до-
ступен для скачивания на странице http://rc2e.com. Аккаунт в Twitter, посвящен-
ный этой книге, – @R_cookbook (https://twitter.com/R_cookbook).

Данная книга призвана помочь вам выполнить свою работу. В общем, вы мо-
жете использовать код из этой книги в своих программах и документации. Вам 
не нужно обращаться к нам за разрешением, если вы не воспроизводите значи-
тельную часть кода. Например, для написания программы, в которой использует-
ся несколько фрагментов кода из этой книги, оно не требуется. Продажа или рас-
пространение CD-ROM с примерами из книг O’Reilly требует разрешения. Чтобы 
ответить на вопрос, сославшись на эту книгу и приведя пример кода, разрешение 
не требуется. Включение значительного количества примеров кода из этой книги 
в документацию вашего продукта требует разрешения.

Атрибуция желательна, но не является обязательной. Обычно она включает в себя 
название книги, автора, издателя и ISBN. Например: «Книга рецептов R, 2-е изд., 
Дж. Д. Лонг и Пол Титор. Copyright 2019 Дж. Лонг и Пол Титор, 978-1-492-04068-2».

Если вы считаете, что применение примеров кода выходит за рамки добро-
совестного использования или только что описанного разрешения, свяжитесь 
с нами по адресу permissions@oreilly.com.

Обучение в режиме онлайн
На протяжении почти 40 лет O’Reilly Media (https://www.oreilly.com) предоставляет 
технологии и бизнес-тренинги, знания и анализ, чтобы помочь компаниям до-
биваться успеха.

Наша уникальная сеть экспертов и новаторов делится своими знаниями и опы-
том через книги, статьи, конференции и нашу онлайн-платформу обучения. Плат-
форма онлайн-обучения O’Reilly предоставляет доступ по требованию к курсам 
обучения в  режиме реального времени, углубленным способам обучения, ин-
терактивным средам кодирования и  обширной коллекции текстов и  видео от 
O’Reilly и свыше 200 других издательств. Для получения дополнительной инфор-
мации, пожалуйста, посетите сайт http://oreilly.com. 
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Как с нами связаться
Пожалуйста, направляйте комментарии и вопросы относительно этой книги из-
дателю:

O’Reilly Media, Inc.
1005 Gravenstein Highway North
Sebastopol, CA 95472
800-998-9938 (в США или Канаде)
707-829-0515 (международный или местный)
707-829-0104 (факс)

У нас есть страница этой книги в  сети, где перечислены ошибки, примеры 
и вся дополнительная информация. Вы можете получить доступ к этой странице 
по адресу http://bit.ly/RCookbook_2e.

Чтобы оставить комментарий или задать технические вопросы об этой книге, 
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Глава 1
Начало работы и получение 

справочной информации

Эта глава закладывает основу для других глав. В ней объяснено, как скачать, уста-
новить и запустить R.

Что еще более важно, в ней также объясняется, как получить ответы на ваши 
вопросы. Сообщество R предоставляет большое количество документации и по-
мощи. Вы не одиноки. Вот несколько распространенных источников справочной 
информации.

Локальная, установленная документация
Когда вы устанавливаете R на свой компьютер, вместе с ним устанавливает-
ся огромное количество документации. Вы можете просматривать локальную 
документацию (рецепт 1.7) и искать ее (рецепт 1.9). Поразительно, насколько 
часто ищем в интернете ответ на тот или иной вопрос только для того, чтобы 
обнаружить, что он уже доступен в установленной документации.

Представления задач
Представление задач (https://cran.r-project.org/web/views/) описывает пакеты, 
которые относятся к  одной из областей статистической работы, такой как 
эконометрика, медицинская визуализация, психометрия или пространствен-
ная статистика. Каждое представление написано и поддерживается экспер-
том в данной области. Существует свыше 35 таких представлений, поэтому, 
вероятно, среди них будет один или несколько, имеющих отношение к вашей 
области интересов. Мы рекомендуем каждому новичку найти и  прочитать 
хотя бы одно из представлений, чтобы познакомиться с возможностями R 
(рецепт 1.12).

Документация пакетов
Большинство пакетов содержат полезную документацию. Документация хра-
нится вместе с  пакетами в  репозиториях пакетов, таких как CRAN (https://
cran.r-project.org), и  автоматически устанавливается на  ваш компьютер при 
установке пакета.

https://cran.r-project.org/web/views/
https://cran.r-project.org
https://cran.r-project.org


Сайты с вопросами и ответами на них
На сайте, содержащем вопросы и ответы на них, каждый может задать вопрос, 
на который могут ответить знающие люди. Читатели голосуют за ответы, по-
этому со временем будут показаны лучшие ответы. Вся эта информация по-
мечается и  архивируется для поиска. Эти сайты представляют собой нечто 
среднее между списком рассылки и  социальной сетью; канонический при-
мер – сайт Stack Overflow (https://stackoverflow.com). 

Сеть
В сети много информации о R, и есть специальные инструменты для ее поиска 
(рецепт 1.11). Информация, содержащаяся в сети, постоянно обновляется, по-
этому ищите новые, улучшенные способы организации и поиска информации 
о языке R.

Списки рассылки
Волонтеры щедро пожертвовали много часов, чтобы ответить на вопросы но-
вичков, которые публикуются в списках рассылок R. Списки архивируются, 
поэтому вы можете искать в архивах ответы на свои вопросы (рецепт 1.13).

1.1. Загрузка и установка R
Задача

Вам необходимо установить R на свой компьютер.

Решение
Пользователи Windows и macOS могут скачать R на сайте CRAN (Comprehensive 

R Archive Network). Пользователи Linux и Unix могут установить пакеты R с по
мощью своего инструмента управления пакетами.

Windows
1.	 �Перейдите на страницу http://www.r-project.org/ в своем браузере.
2.	 ��Нажмите CRAN. Вы увидите список зеркал сайта, упорядоченных по стра-

нам.
3.	 ��Выберите ближайший к вам сайт или самый первый указанный в верхней 

части списка (0-Cloud), который, как правило, хорошо работает для боль-
шинства местоположений (https://cloud.r-project.org/).

4.	 �Нажмите Download R for Windows (Скачать R для Windows) в  разделе 
Download and Install R (Скачать и установить R).

5.	Нажмите base.
6.	Нажмите на ссылку, чтобы скачать последнюю версию R (файл .exe).
7.	 �По завершении загрузки дважды щелкните файл .exe и ответьте на привыч-

ные вопросы.

macOS
1.	 �Перейдите на страницу http://www.r-project.org/ в своем браузере.
2.	 �Нажмите CRAN. Вы увидите список зеркал сайта, упорядоченных по странам.
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3.	 �Выберите ближайший к вам сайт или самый первый указанный в верхней 
части списка (0-Cloud), который, как правило, хорошо работает для боль-
шинства местоположений.

4.	 �Нажмите Download R for (Mac) OS X (Скачать R для (Mac) OS X).
5.	 �Нажмите на файл .pkg для последней версии R в разделе Latest release (По-

следний выпуск), чтобы скачать его.
6.	 �По завершении загрузки дважды щелкните файл .pkg и ответьте на привыч-

ные вопросы.

Linux или Unix
В основных дистрибутивах Linux есть пакеты для установки R. В табл. 1-1 приве-
дены примеры. 

Таблица 1-1. Дистрибутивы Linux 

Дистрибутив Название пакета

Ubuntu или Debian r-base

Red Hat или Fedora R.i386 

SUSE R-base

Используйте системный менеджер пакетов для скачивания и установки пакета. 
Вам понадобится пароль администратора или привилегии sudo; в противном слу-
чае попросите системного администратора выполнить установку.

Обсуждение 
Установка R в Windows или macOS проста, потому что для этих платформ сущест
вуют готовые двоичные файлы (скомпилированные программы). Вам нужно 
всего лишь следовать предыдущим инструкциям. Страницы CRAN также содер-
жат ссылки на  ресурсы, связанные с  установкой, например задаваемые вопро-
сы (FAQ) и советы для особых ситуаций («Работает ли R на Windows Vista / 7/8 / 
Server 2008?»), что может оказаться полезным.

Наиболее подходящий способ установить R в  Linux или Unix – использовать 
диспетчер пакетов дистрибутивов Linux для установки R в виде пакета. Дистрибу-
тивные пакеты значительно упрощают как первоначальную установку, так и по-
следующие обновления.

В Ubuntu или Debian используйте команду apt-get для загрузки и установки R. 
Воспользуйтесь утилитой sudo, чтобы получить необходимые привилегии:

$ sudo apt-get install r-base 

В Red Hat или Fedora используйте yum:
$ sudo yum install R.i386

Большинство платформ Linux также имеют графические менеджеры пакетов, 
которые могут оказаться более удобными.

Помимо базовых пакетов, мы рекомендуем также установить пакеты докумен-
тации. Нам нравится r-base-html (потому что мы любим просматривать докумен-
тацию с гиперссылками), а также r-doc-html, который устанавливает важные руко-
водства по R локально:
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$ sudo apt-get install r-base-html r-doc-html

Некоторые репозитории Linux включают в себя готовые копии пакетов R, до-
ступных в CRAN. Мы не используем их, потому что предпочитаем получать про-
граммное обеспечение непосредственно от самого CRAN, где обычно имеются 
самые свежие версии.

В редких случаях вам может понадобиться выполнить сборку R с нуля. У вас 
может быть неподдерживаемая версия Unix, или у вас могут быть особые сообра-
жения относительно производительности или конфигурации. Процедура сборки 
в Linux или Unix вполне стандартна. Скачайте архив с домашней страницы ваше-
го зеркала CRAN; он будет называться как-нибудь вроде R-3.5.1.tar.gz, за  исклю-
чением того, что вместо 3.5.1 будет указана последняя версия. Распакуйте архив, 
найдите файл с именем INSTALL и следуйте инструкциям.

См. также 
В книге R in a Nutshell Джозефа Адлера (издательство O’Reilly) содержится более 
подробная информация о загрузке и установке R, включая инструкции по сборке 
версий для Windows и macOS. Возможно, самым полным является руководство 
по установке и администрированию R, доступное в CRAN, где описывается сборка 
и установка R на различных платформах.

Это рецепт установки базового пакета. См. рецепт 3.10 для установки пакетов 
дополнений из CRAN.

1.2. Установка RStudio

Задача 
Вам нужна более комплексная интегрированная среда разработки (IDE), чем 
та, что есть в R по умолчанию. Другими словами, вы хотите установить RStudio 
Desktop.

Решение
За последние несколько лет RStudio стал наиболее широко используемой интегри-
рованной средой разработки для R. Мы считаем, что почти вся работа с R должна 
выполняться в среде разработки RStudio Desktop, если нет веской причины посту-
пить иначе. RStudio производит ряд продуктов, включая RStudio Desktop, RStudio 
Server и RStudio Shiny Server среди прочих. В этой книге мы будем использовать 
термин RStudio для обозначения RStudio Desktop, хотя большинство концепций 
применимо и к RStudio Server.

Чтобы установить RStudio, загрузите последнюю версию установщика для ва-
шей платформы с сайта RStudio (https://rstudio.com/products/rstudio/download/). 

Версию RStudio Desktop с открытым исходным кодом можно скачать и исполь-
зовать бесплатно.

Обсуждение
В этой книге используются RStudio версии 1.2.x и R версии 3.5.x. Новые версии 
RStudio выпускаются каждые несколько месяцев, поэтому регулярно обновляй-
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те их. Обратите внимание, что RStudio работает с любой версией R, которую вы 
установили, поэтому обновление до последней версии RStudio не обновляет вашу 
версию R. R необходимо обновлять отдельно.

Взаимодействие с R в RStudio немного отличается от встроенного пользова-
тельского интерфейса R. Для этой книги мы решили использовать RStudio для 
всех примеров. 

1.3. Запуск RStudio

Задача 
Вы хотите запустить RStudio на своем компьютере.

Решение 
Распространенная ошибка, которую допускают новые пользователи R и RStudio, – 
это случайный запуск R, когда они намеревались запустить RStudio. Самый прос
той способ убедиться в том, что вы действительно запускаете RStudio, – это най-
ти RStudio на своем рабочем столе, а затем использовать любой метод, который 
предоставляет ваша ОС для закрепления иконки там, где ее легко можно будет 
найти позже:

Windows
Нажмите на меню Пуск в левом нижнем углу экрана. В поле поиска введите 
RStudio.

macOs 
Найдите в  панели запуска приложение RStudio или нажмите Cmd-space 
(Cmd – это команда или клавиша )) и введите RStudio, чтобы выполнить по-
иск с помощью Spotlight Search.

Ubuntu
Нажмите сочетание клавиш Alt-F1 и введите RStudio для поиска RStudio.

Обсуждение 
На рис. 1-1, видно, что иконки  R и RStudio похожи , что может привести вас в за-
мешательство

Рис. 1-1. Иконки R и RStudio в macOS
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Если вы нажмете на значок R, то увидите нечто похожее на то, что изображено 
на рис. 1-2. Это базовый интерфейс R в Mac, но, конечно же, не RStudio.

Рис. 1-2. Консоль R в macOS 

Когда вы запускаете RStudio, по умолчанию он снова откроет последний про-
ект, над которым вы работали в RStudio.

1.4. Ввод команд

Задача
Вы запустили RStudio. Что теперь?

Решение
Когда вы запускаете RStudio, главное окно в левой части экрана – это сеанс R. От-
туда вы можете вводить команды в интерактивном режиме непосредственно в R.

Обсуждение
Приглашение командной строки в R выглядит так: >. Для начала просто воспри-
нимайте R как большой калькулятор: введите выражение, а R вычислит его и вы-
ведет результат:
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> 1+1

[1] 2
>

Компьютер складывает 1 и 1 и отображает результат, 2.
[1] перед 2 может сбивать с толку. Для R результат – это вектор, хотя у него име-

ется только один элемент. R помечает значение с помощью [1], чтобы показать, 
что это первый элемент вектора... что неудивительно, поскольку это единствен-
ный элемент вектора.

R будет запрашивать ввод, пока вы не введете полное выражение. Выражение 
max(1,3,5) является полным, поэтому R прекращает чтение ввода и вычисляет то, 
что получил:

> max(1, 3,  
+5)

[1] 5

>

max (1,3, напротив, представляет собой неполное выражение, поэтому R запра-
шивает дополнительный ввод. Вместо знака «больше, чем» (>) появится «плюс» 
(+), сообщая, что R ожидает большего:

> max(1, 3, +5)

[1] 5

>

Команды легко набирать неправильно, а вводить их снова утомительно и не-
приятно. Таким образом, R включает редактирование командной строки, чтобы 
сделать жизнь проще. Он определяет одиночные нажатия клавиш, которые по-
зволяют легко вызывать, исправлять и повторно выполнять ваши команды. Ти-
пичное взаимодействие с командной строкой выглядит так:

1.	Вы вводите выражение с опечаткой.
2.	R жалуется на вашу ошибку.
3.	Вы нажимаете клавишу со стрелкой вверх, чтобы вызвать на экран строку, 

в которой есть ошибка.
4.	Вы используете клавиши со стрелками влево и вправо, чтобы переместить 

курсор назад к ошибке.
5.	Вы используете клавишу Delete, чтобы удалить неправильные символы.
6.	Вы вводите исправленные символы, которые вставляются в  командную 

строку.
7.	 Вы нажимаете Enter, чтобы повторно выполнить исправленную команду.
Это лишь основы. R поддерживает обычные нажатия клавиш для вызова и ре-

дактирования командных строк, как показано в табл. 1-2.
В большинстве операционных систем также можно использовать мышь, что-

бы выделить команды, а  затем использовать обычные команды копирования 
и вставки, чтобы вставить текст в новую командную строку.

1.4. Ввод команд    25



Таблица 1-2. Оперативные клавиши выбора в R 

Маркированная клавиша Сочетание клавиш Результат

Up arrow Ctrl-P Вспомнить предыдущую команду, перемещаясь назад 
по истории команд

Down arrow Ctrl-N Движение вперед по истории команд

Backspace Ctrl-H Удалить символ слева от курсора

Delete (Del) Ctrl-D Удалить символ справа от курсора

Home Ctrl-A Переместить курсор в начало строки

End Ctrl-E Переместить курсор в конец строки

Right arrow Ctrl-F Переместить курсор вправо (вперед) на один символ

Left arrow Ctrl-B Переместить курсор влево (назад) на один символ

Ctrl-K Удалить все начиная от положения курсора до конца 
строки

Ctrl-U Очистить всю чертову строку и начать все сначала

Tab Автодополнение имени (на некоторых платформах)

См. также 
См. рецепт 2.12. В главном меню Windows выберите Справка → Консоль для 
получения полного списка нажатий клавиш, полезных для редактирования в ко-
мандной строке.

1.5. Выход из RStudio

Задача 
Вам нужно выйти из RStudio.

Решение

Windows и большинство дистрибутивов Linux
Выберите Select File → Quit Session (Файл → Выйти из сеанса) в главном меню 
или нажмите X в верхнем правом углу окна.

macOS
Выберите Select File → Quit Session (Файл → Выйти из сеанса) в главном меню, 
или нажмите Cmd-Q, либо щелкните красный кружок в верхнем левом углу окна.

На всех платформах вы также можете использовать функцию q (как в quit) для 
завершения сеанса R и RStudio:

q()

Обратите внимание на пустые скобки, которые необходимы для вызова функции.

Обсуждение 
Каждый раз, когда вы выходите, R обычно спрашивает, хотите ли вы сохранить 
рабочее пространство. У вас есть три варианта:
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�� сохранить рабочее пространство и выйти;
�� не сохранять свое рабочее пространство и все равно выйти;
�� выполнить отмену, вернувшись в командную строку, вместо того чтобы выйти.

Если вы сохраняете свое рабочее пространство, R записывает его в файл с име-
нем .RData в текущем рабочем каталоге. При сохранении рабочей области сохра-
няются любые объекты R, которые вы создали. В следующий раз, когда вы запус
тите R в том же каталоге, рабочая область будет загружена автоматически. При 
сохранении вашей рабочей области ранее сохраненная рабочая область будет 
перезаписана, если таковая имеется, поэтому не сохраняйте ее, если вам не нра-
вятся ваши изменения (например, если вы случайно удалили важные данные из 
своего рабочего пространства).

Мы рекомендуем никогда не  сохранять рабочее пространство при выходе 
и вместо этого всегда в явном виде сохранять проект, сценарии и данные. Мы также 
рекомендуем отключить приглашение к вводу команды, чтобы сохранить и авто-
матически восстановить рабочее пространство в RStudio, используя глобальные па-
раметры, которые находятся в меню Tools → Global Options (Инструменты → Гло-
бальные параметры) и показаны на рис. 1-3. Таким образом, когда вы выходите из 
R и RStudio, вам не будет предложено сохранить рабочее пространство. Но имейте 
в виду, что любые объекты, созданные, но не сохраненные на диск, будут потеряны!

Рис. 1-3. Параметры сохранения рабочего пространства
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См. также 
См. рецепт 3.1 для получения дополнительной информации о текущем рабочем 
каталоге и рецепт 3.3 для получения дополнительной информации о сохранении 
рабочего пространства. Также см. вторую главу книги R in a Nutshell.

1.6. Прерывание R
Задача 
Вам нужно прервать длительные вычисления и вернуться в командную строку, 
не выходя из RStudio.

Решение
Нажмите клавишу Esc на  клавиатуре или щелкните на  меню Session (Сеанс) 
в RStudio и выберите Interrupt R (Прервать R). Вы также можете щелкнуть значок 
знака остановки в окне консоли кода.

Обсуждение
Прерывание R означает указание R прекратить выполнение текущей команды, но 
без удаления переменных из памяти или полного закрытия RStudio. Тем не менее 
прерывание R может оставить ваши переменные в неопределенном состоянии, 
в зависимости от того, насколько далеко продвинулись вычисления, поэтому про-
верьте свое рабочее пространство после прерывания.

См. также
См. рецепт 1.5.

1.7. Просмотр прилагаемой документации 
Задача 
Вы хотите прочитать документацию, поставляемую с R.

Решение
Используйте функцию help.start, чтобы увидеть оглавление документации:

help.start()

Отсюда доступны ссылки для всей установленной документации. В RStudio 
справка будет отображаться на панели справки, которая по умолчанию находится 
в правой части экрана.

В RStudio также можно нажать Help → R Help (Справка → Справка R), чтобы 
получить список с опциями справки как для R, так и для RStudio.

Обсуждение
Базовый дистрибутив R включает в  себя множество документации – буквально 
тысячи страниц. При установке дополнительных пакетов эти пакеты содержат до-
кументацию, которая также установлена на вашем компьютере.
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Эту документацию легко просмотреть с помощью функции help.start, которая 
открывает оглавление верхнего уровня. На рис. 1-4 показано, как help.start ото-
бражается на панели справки в RStudio.

Рис. 1-4. help.start в RStudio

Две ссылки в разделе «Базовый справочник R» особенно полезны:

Пакеты (Packages)
Нажмите здесь, чтобы увидеть список всех установленных пакетов – как ба-
зовых, так и установленных дополнительно. Нажмите на имя пакета, чтобы 
увидеть список его функций и наборов данных.

Поисковая система и ключевые слова (Search Engine & Keywords)
Нажмите здесь, чтобы получить доступ к простой поисковой системе, которая 
позволяет выполнять поиск в документации по ключевому слову или фразе. 
Существует также список распространенных ключевых слов, организованных 
по темам; щелкните на одно из них, чтобы увидеть связанные страницы.

Базовая документация R, доступ к которой осуществляется через help.start, за-
гружается на ваш компьютер при установке R. Справка RStudio, доступ к которой 
вы получаете с помощью опции меню Help → R Help (Справка → Справка R), 
представляет страницу с ссылками на сайт RStudio. Таким образом, вам понадо-
бится доступ в интернет для доступа к справочным ссылкам RStudio.
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См. также 
Локальная документация скопирована с сайта R Project (https://www.r-project.org), 
где могут быть обновленные документы.

1.8. Получение справки по функции

Задача 
Вы хотите больше узнать о функции, которая установлена на вашем компьютере.

Решение
Используйте функцию help для отображения документации по функции:

help(имяфункции)

Используйте функцию args для быстрого напоминания аргументов функции:
args(имяфункции)

Используйте функцию example, чтобы увидеть примеры использования функции:
example(имяфункции)

Обсуждение
В этой книге мы представляем много функций R. Каждая функция имеет больше 
дополнительных свойств, чем мы можем описать. Если функция заинтересовала 
вас, мы настоятельно рекомендуем прочитать страницу справки для этой функ-
ции. Одно из таких свойств может оказаться очень полезным для вас.

Предположим, вы хотите узнать больше о функции mean. Используйте функцию 
help:

help mean

Откроется страница справки для функции mean на панели справки в RStudio. 
Для быстрого вызова команды help просто наберите ?, за которым следует имя 
функции:

?mean 

Иногда вам просто нужно быстрое напоминание об аргументах функции: ка-
ковы они и в каком порядке встречаются? Для этого случая используйте функ-
цию args:

args(mean)
#> function (x, ...)
#> NULL

args(sd)
#> function (x, na.rm = FALSE)
#> NULL

Первая строка вывода представляет собой краткий обзор вызова функции. В слу-
чае с mean в синопсисе показан один аргумент, x, который представляет собой вектор 
чисел. В случае с sd синопсис показывает тот же вектор, x и необязательный аргу-
мент na.rm. (Вторую строку вывода, которая часто представляет собой просто NULL, 
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можно игнорировать.) В RStudio вы будете видеть вывод args в виде всплывающей 
подсказки над курсором при вводе имени функции, как показано на рис. 1-5.

Рис. 1-5. Подсказка RStudio 

Большая часть документации по функциям содержит пример кода в конце до-
кумента. Отличная особенность R заключается в том, что вы можете запросить 
выполнение примеров, в результате чего увидите небольшую демонстрацию воз-
можностей функции. Например, в документации функции mean содержатся при-
меры, но вам не нужно вводить их самостоятельно: просто используйте функцию 
example, чтобы увидеть их выполнение:

example(mean)
#>
#> mean> x <- c(0:10, 50)
#>
#> mean> xm <- mean(x)
#>
#> mean> c(xm, mean(x, trim = 0.10))
#> [1] 8.75 5.50

Все, что вы видите после example(mean), было создано R, который выполнил при-
меры со страницы справки и отобразил результаты.

См. также 
См. рецепт 1.9 для поиска функций и рецепт 3.6 для получения дополнительной 
информации о пути поиска.

1.9. Поиск в прилагаемой документации 
Задача 
Вы хотите узнать больше о функции, которая установлена на вашем компьютере, 
но функция help сообщает, что не может найти подходящую документацию.

Или же вы хотите найти в установленной документации ключевое слово.

Решение
Используйте функцию help.search для поиска в документации R на своем компью
тере:

help.search("шаблон")
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Типичным шаблоном является имя функции или ключевое слово. Обратите 
внимание, что он должен быть заключен в кавычки.

Для своего удобства вы также можете вызвать поиск, используя два вопроси-
тельных знака (в этом случае кавычки не требуются). Обратите внимание, что для 
поиска функции по имени используется один знак вопроса, а для поиска тексто-
вого шаблона – два:

> ??шаблон

Обсуждение
Время от времени вы можете запрашивать справку по функции, только чтобы по-
лучить сообщение, в котором говорится, что R ничего о ней неизвестно:

help(adf.test)
#> No documentation for 'adf.test' in specified packages and libraries:
#> you could try '??adf.test'

Если вы знаете, что функция установлена на  вашем компьютере, это может 
быть неприятно. Проблема здесь состоит в том, что пакет функции в данный мо-
мент не загружен, и вы не знаете, в каком пакете содержится эта функция. Это 
своего рода уловка-22 (сообщение об ошибке указывает на то, что пакет в данный 
момент отсутствует в вашем пути поиска, поэтому R не может найти файл справ-
ки; см. рецепт 3.6 для получения более подробной информации).

Решение заключается в поиске всех установленных пакетов для этой функции. 
Просто используйте функцию help.search, как указано в сообщении об ошибке:

help.search("adf.test")

Поиск выдаст список всех пакетов, которые содержат эту функцию:

Help files with alias or concept or title matching 'adf.test' using
regular expression matching:

tseries::adf.test 	 Augmented Dickey-Fuller Test
Type '?PKG::FOO' to inspect entry 'PKG::FOO TITLE'.

Предыдущий вывод показывает, что пакет tseries содержит функцию adf.test. 
Можно увидеть ее документацию, явно указав справке, какой пакет содержит 
функцию:

help(adf.test, package = "tseries") 

или можно использовать оператор двойного двоеточия, чтобы указать R выпол-
нить поиск в определенном пакете:

?tseries::adf.test

Вы можете расширить свой поиск, используя ключевые слова. Затем R найдет 
любую установленную документацию, которая содержит ключевые слова. Пред-
положим, вы хотите найти все функции, в которых упоминается расширенный 
тест Дики–Фуллера (ADF). Можно искать по вероятному шаблону:

help.search("dickey-fuller")
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См. также
Вы также можете получить доступ к локальной поисковой системе через браузер 
документации; см. рецепт 1.7, чтобы узнать, как это сделать. См. рецепт 3.6 для 
получения дополнительной информации о пути поиска и рецепт 1.8 для получе-
ния справки по функциям.

1.10. Получение справки по пакету 
Задача 
Вы хотите узнать больше о пакете, установленном на вашем компьютере.

Решение
Используйте функцию help и укажите имя пакета (без имени функции):

help(package = "имяпакета") 

Обсуждение
Иногда вам нужно знать содержимое пакета (функции и наборы данных).

Это особенно верно, например, после загрузки и  установки нового пакета. 
Функция help может предоставить содержимое плюс другую информацию, как 
только вы укажете имя пакета.

В результате этого вызова функции help будет показана информация для пакета 
tseries, стандартного пакета в базовом дистрибутиве:

help(package = "tseries") 

Эта информация начинается с описания и продолжается указателем функций 
и наборов данных. В RStudio страница справки в формате HTML откроется в окне 
справки интегрированной среды разработки.

Некоторые пакеты также содержат сопроводительную документацию, это 
введения, учебные пособия или справочные карточки. Они устанавливаются 
на ваш компьютер как часть документации пакета при его инсталляции. Стра-
ница справки для пакета содержит список сопроводительной документации 
в нижней части.

Вы можете просмотреть этот список на своем компьютере, используя функцию 
vignette: 

vignette() 

В RStudio откроется новая вкладка со списком всех пакетов, установленных 
на вашем компьютере, которые содержат виньетки, а также их названия и опи-
сания.

Можно увидеть документацию для конкретного пакета, включив его название:
vignette(package = "имяпакета") 

У каждой виньетки есть имя, которое используется для ее просмотра:
vignette("имявиньетки")
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См. также 
См. рецепт 1.8 для получения справки по конкретной функции в пакете.

1.11. Поиск справки в интернете 
Задача
Вам нужно найти в интернете информацию и ответы, касающиеся R.

Решение
Внутри R используйте функцию RSiteSearch для поиска по ключевому слову или 
фразе:

RSiteSearch("ключевая фраза") 

В своем браузере  попробуйте использовать приведенные ниже сайты для поиска:
RSeek (https://rseek.org) 

Это пользовательская поисковая система Google, ориентированная на сайты, 
посвященные R.

Stack Overflow (https://stackoverflow.com) 
Stack Overflow – сайт с вопросами и ответами с возможностью поиска от сети 
Stack Exchange, который ориентирован на такие проблемы программирова-
ния, как структуры данных, кодирование и графика. Stack Overflow – отличная 
«первая остановка» для всех ваших вопросов, касающихся синтаксиса.

Cross Validated (https://stats.stackexchange.com) 
Cross Validated – это сайт Stack Exchange, нацеленный на статистику, машинное 
обучение и анализ данных, а не на программирование. Это хорошее место, что-
бы задать вопрос по поводу того, какой статистический метод использовать.

Сообщество RStudio (https://community.rstudio.com) 
Сайт сообщества RStudio  – это дискуссионный форум, организованный 
RStudio. Темы включают в  себя R, RStudio и  связанные с ними технологии. 
Поскольку этот форум посвящен RStudio, его часто посещают сотрудники 
компании RStudio Inc и те, кто нередко использует это программное обеспе-
чение. Это неплохое место для вопросов общего характера и вопросов, кото-
рые, возможно, не  вписываются в формат, ориентированный на  синтаксис 
Stack Overflow.

Обсуждение 
Функция RSiteSearch откроет окно браузера и направит его в поисковую систему 
на сайте R Project (http://search.r-project.org). Здесь вы можете уточнить параметры 
поиска. Например, так мы ищем термин «каноническая корреляция»:

RSiteSearch("canonical correlation")

Это очень удобно. Таким образом можно выполнять быстрый поиск, не выходя 
из R. Однако область поиска ограничена документацией R и архивами списков 
рассылки.
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RSeek (https://rseek.org) обеспечивает более широкий поиск. Его достоинство 
заключается в  том, что он использует всю мощь поисковой системы Google, 
концентрируясь на сайтах, имеющих отношение к R, и исключает посторонние 
результаты общего поиска Google. Прелесть RSeek в том, что он организует ре-
зультаты полезным способом.

На рис. 1-6 показаны результаты посещения сайта RSeek и  поиска термина 
«корреляция». Обратите внимание, что вкладки в верхней части позволяют пере-
ходить к различным типам контента:

�� All results (Все результаты);
�� Packages (Пакеты);
�� Books (Книги);
�� Support (Служба поддержки);
�� Articles (Статьи);
�� For Beginners (Для начинающих).

Рис. 1-6. RSeek 

Stack Overflow (https://stackoverflow.com) – это сайт с  вопросами и  ответами. 
Это означает, что любой может отправить вопрос, а опытные пользователи дадут 
на него ответы – часто на каждый вопрос есть несколько ответов. Читатели голо-
суют за ответы, поэтому хорошие ответы обычно поднимаются наверх, что созда-
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ет богатую базу данных диалогов, состоящих из вопросов и ответов, по которым 
можно выполнять поиск. Stack Overflow ориентирован главным образом на реше-
ние проблем, и темы прежде всего касаются программирования на языке R.

Stack Overflow содержит вопросы по многим языкам программирования; по-
этому при вводе термина в  поле поиска добавьте к  нему «[r]», чтобы сфокуси-
ровать поиск на  вопросах, касающихся R. Например, при поиске «стандартная 
ошибка [r]» будут выбраны только вопросы, помеченные как касающиеся языка R, 
и вам не будут попадаться вопросы по Python и C ++.

Stack Overflow также включает в  себя статью о  языке R (https://stackoverflow.
com/tags/r/info), которая предоставляет превосходный список онлайн-ресурсов 
для сообщества.

У Stack Exchange (материнская компания Stack Overflow) есть сайт для статис
тического анализа под названием Cross Validated (https://stats.stackexchange.com). 
Этот сайт больше сфокусирован на статистике, нежели на программировании, по-
этому используйте его при поиске ответов, которые больше касаются статистики 
в целом, а не R в частности.

У RStudio также есть собственный форум (https://community.rstudio.com). Это от-
личное место, чтобы задавать общие и более концептуальные вопросы, которые 
могут не дать нужного результата на Stack Overflow.

См. также 
Если в результате поиска вы обнаружите полезный пакет, используйте рецепт 3.10, 
чтобы установить его на свой компьютер.

1.12. Поиск соответствующих функций и пакетов 
Задача
Из 10 000+ пакетов для R вы не знаете, какие из них будут вам полезны.

Решение 
Чтобы найти пакеты, относящиеся к  определенной области, посетите список 
представлений задач CRAN (https://cran.r-project.org/web/views/). Выберите пред-
ставление задачи для вашей области, которая даст вам описания соответствую-
щих пакетов и ссылки на них. Или посетите сайт RSeek (https://rseek.org), выпол-
ните поиск по  ключевому слову, перейдите на  вкладку Представления задач 
и выберите подходящее представление.

Посетите сайт https://crantastic.org и поищите пакеты по ключевому слову.
�� Чтобы найти соответствующие функции, посетите сайт RSeek, выполните 
поиск по имени или ключевому слову и нажмите на вкладку Функции.

Обсуждение
Эта проблема особенно неприятна для начинающих. Вы думаете, что R может ре-
шить ваши проблемы, но не знаете, какие пакеты и функции были бы полезны. 
Распространенный вопрос, встречающийся в  списках рассылки: «Существует ли 
какой-нибудь пакет для решения проблемы X?» Это тихий крик того, кто тонет в R.

36    Начало работы и получение справочной информации

https://stackoverflow.com/tags/r/info
https://stackoverflow.com/tags/r/info
https://stats.stackexchange.com
https://community.rstudio.com
https://cran.r-project.org/web/views/
https://rseek.org
https://crantastic.org


На момент написания этих строк доступно свыше 10 000 пакетов для бесплат-
ной загрузки с CRAN. У каждого пакета имеется страница с кратким описанием 
и ссылками на документацию. Найдя потенциально интересный пакет, вы обыч-
но нажимаете ссылку Reference manual (Справочное руководство), чтобы про-
смотреть документацию в формате PDF со всеми подробностями. (Сводная стра-
ница также содержит ссылки на скачивание для установки пакета, но вы редко 
устанавливаете пакет таким образом; см. рецепт 3.10.)

Иногда у вас просто есть общий интерес – например, байесовский анализ, эко-
нометрика, оптимизация или графика. CRAN содержит набор страниц с  пред-
ставлениями задач, описывающих пакеты, которые могут быть полезны. Пред-
ставление задач – отличное место для начала, поскольку вы получаете обзор того, 
что доступно. Вы можете просмотреть список страниц с представлениями задач 
по адресу https://cran.r-project.org/web/views/ или выполнить их поиск, как описано 
в решении. Представления задач CRAN перечисляют ряд широких сфер деятель-
ности и показывают пакеты, которые используются в каждой области. Например, 
существуют представления задач для высокопроизводительных вычислений, ге-
нетики, временных рядов и социальных наук, и это лишь некоторые из них.

Предположим, вы знаете название полезного пакета, скажем, увидев его в ин-
тернете. Полный список пакетов в алфавитном порядке доступен по адресу https://
cran.r-project.org/web/packages/.

См. также 
Вы можете скачать и установить пакет R под названием sos, который предостав-
ляет другие мощные способы поиска пакетов; см. https://cran.r-project.org/web/
packages/sos/vignettes/sos.pdf. 

1.13. Поиск в списках рассылки 
Задача 
У вас есть вопрос, и вы хотите найти его в  архивах списков рассылки, чтобы 
узнать, был ли ранее дан ответ на ваш вопрос. 

Решение
Перейдите на  страницу https://r.789695.n4.nabble.com. Выполните поиск по клю-
чевому слову или другому поисковому запросу из вашего вопроса. Вы увидите 
результаты из списков рассылки поддержки.

Обсуждение
Данный рецепт в действительности является всего лишь приложением рецепта 1.11. 
Но это важное приложение, потому что вы должны выполнить поиск в архивах спис
ка рассылки, прежде чем отправлять новый вопрос в список. На ваш вопрос, вероят-
но, уже есть ответ.

См. также 
В CRAN есть список дополнительных ресурсов для поиска в сети; см. https://cran.r-
project.org/search.html. 
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1.14. Отправка вопросов в Stack Overflow или в другое 
место в сообществе

Задача
У вас есть вопрос, на который вы не можете найти ответ в интернете, поэтому вы 
хотите отправить вопрос сообществу R.

Решение
Первое, что необходимо сделать, чтобы задать вопрос онлайн, – создать воспроизво-
димый пример. Наличие примера кода, который можно выполнить и четко увидеть 
вашу проблему, является наиболее важной частью обращения за помощью онлайн. 
Вопрос с хорошим воспроизводимым примером состоит из трех компонентов:

Пример данных
Это могут быть смоделированные данные или какие-либо реальные данные, 
которые вы предоставляете.

Пример кода
Этот код показывает, что вы пытались сделать что-то, или ошибку, которую 
вы получаете.

Письменное описание
Здесь вы объясняете, что у вас есть, что бы вы хотели и что вы пробовали сде-
лать, но это не сработало.

Подробности написания воспроизводимого примера приведены в разделе «Об-
суждение». Получив воспроизводимый пример, вы можете опубликовать свой во-
прос на сайте Stack Overflow (https://stackoverflow.com/users/login?ssrc=anon_ask&re
turnurl=https%3a%2f%2fstackoverflow.com%2fquestions%2fask). Обязательно включи-
те тег r в разделе «Теги» на странице вопросов.

Если ваш вопрос носит более общий характер или связан с концепциями, а не 
с конкретным синтаксисом, RStudio организует дискуссионный форум сообщест
ва RStudio (https://community.rstudio.com). Обратите внимание, что этот сайт разбит 
на несколько тем, поэтому выберите категорию тем, которая наилучшим образом 
соответствует вашему вопросу.

Вы также можете отправить свой вопрос в списки рассылки R (но не отправ-
ляйте его на несколько сайтов, в списки рассылки и Stack Overflow, поскольку это 
воспринимается как грубый кросспостинг).

Страница списков рассылки (https://www.r-project.org/mail.html) содержит об-
щую информацию и инструкции по использованию списка рассылки Rhelp. Вот 
как выглядит этот процесс в общих чертах:

1.	Подпишитесь на  основной список рассылки R, R-help (https://stat.ethz.ch/
mailman/listinfo/r-help). 

2.	Тщательно и правильно напишите свой вопрос и включите туда свой вос-
производимый пример.

3.	Отправьте свой вопрос по адресу r-help@r-project.org.

38    Начало работы и получение справочной информации

https://stackoverflow.com/users/login?ssrc=anon_ask&returnurl=https%3a%2f%2fstackoverflow.com%2fquestions%2fask
https://stackoverflow.com/users/login?ssrc=anon_ask&returnurl=https%3a%2f%2fstackoverflow.com%2fquestions%2fask
https://community.rstudio.com
https://www.r-project.org/mail.html
https://stat.ethz.ch/mailman/listinfo/r-help
https://stat.ethz.ch/mailman/listinfo/r-help


Обсуждение
Список рассылки R-help, Stack Overflow и  сайт сообщества RStudio – отличные 
ресурсы, но, пожалуйста, относитесь к ним как к последнему средству. Прочти-
те страницы справки, документацию, выполните поиск в архивах и в интернете. 
Скорее всего, на ваш вопрос уже есть ответ. Не обманывайте себя: очень немногие 
вопросы уникальны. Если вы исчерпали все другие варианты, возможно, пришло 
время создать хороший вопрос.

Воспроизводимый пример – основа хорошего запроса о помощи. Первый ком-
понент – пример данных. Хороший способ получить его – смоделировать данные, 
используя несколько функций R.

В приведенном ниже примере мы создали таблицу данных example_df с тремя 
столбцами, каждый из которых имеет свой тип данных:

set.seed(42)
n <- 4
example_df <- data.frame(

some_reals = rnorm(n),
some_letters = sample(LETTERS, n, replace = TRUE),
some_ints = sample(1:10, n, replace = TRUE)

)
example_df
#> 		 some_reals 	 some_letters 	 some_ints
#> 1 		 1.371 					    R 						     10
#> 2 		 -0.565 				    S 						     3
#> 3 		 0.363 					    L 						     5
#> 4 		 0.633 					    S 						     10

Обратите внимание, что в этом примере вначале используется команда set.
seed. Это гарантирует, что при каждом запуске этого кода ответы будут одина-
ковыми. Значение n – это число строк примеров данных, которые вы хотели бы 
создать. Сделайте ваш пример данных максимально простым, чтобы проиллюст
рировать свой вопрос.

Альтернативой созданию смоделированных данных является использование 
примера данных, поставляемых с R. Например, набор данных mtcars содержит 
таблицу данных с 32 записями о различных моделях автомобилей:

data(mtcars)
head(mtcars)
#> 										         mpg 		 cyl disp 	 hp 	drat 	wt 		 qsec 	 vs 	am 	gear carb
#> Mazda RX4 					    21.0 	6 		 160 		 110 	3.90 	2.62 	 16.5 	 0 		 1 		 4 		 4
#> Mazda RX4 Wag 			  21.0 	6 		 160 		 110 	3.90 	2.88 	 17.0 	 0 		 1 		 4 		 4
#> Datsun 710 				    22.8 	4 		 108 		 93 	3.85 	2.32 	 18.6 	 1 		 1 		 4 		 1
#> Hornet 4 Drive 			  21.4 	6 		 258 		 110 	3.08 	3.21 	 19.4 	 1 		 0 		 3 		 1
#> Hornet Sportabout 	 18.7 	8 		 360 		 175 	3.15 	3.44 	 17.0 	 0 		 0 		 3 		 2
#> Valiant 						     18.1 	6 		 225 		 105 	2.76 	3.46 	 20.2 	 1 		 0 		 3 		 1

Если ваш пример воспроизводим только с  вашими собственными данными, 
вы можете использовать dput, чтобы поместить часть собственных данных в стро-
ку, которую можно использовать в  своем примере. Мы проиллюстрируем этот 
подход, используя две строки из набора данных mtcars:

dput(head(mtcars, 2))
#> structure(list(mpg = c(21, 21), cyl = c(6, 6), disp = c(160,
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#> 160), hp = c(110, 110), drat = c(3.9, 3.9), wt = c(2.62, 2.875
#> ), qsec = c(16.46, 17.02), vs = c(0, 0), am = c(1, 1), gear = c(4,
#> 4), carb = c(4, 4)), row.names = c("Mazda RX4", "Mazda RX4 Wag"
#> ), class = "data.frame")

Вы можете поместить полученную структуру прямо в ваш вопрос:
example_df <- structure(list(mpg = c(21, 21), cyl = c(6, 6), disp = c(160,
160), hp = c(110, 110), drat = c(3.9, 3.9), wt = c(2.62, 2.875
), qsec = c(16.46, 17.02), vs = c(0, 0), am = c(1, 1), gear = c(4,
4), carb = c(4, 4)), row.names = c("Mazda RX4", "Mazda RX4 Wag"
), class = "data.frame")

example_df
#> 								       mpg 		 cyl disp 	 hp 		 drat 	wt 		 qsec 	 vs 	am gear carb
#> Mazda RX4 			  21 		 6 		 160 		 110 		 3.9 		 2.62 	 16.5 	 0 		 1 		 4 		 4
#> Mazda RX4 Wag 	21 		 6 		 160 		 110 		 3.9 		 2.88 	 17.0 	 0 		 1 		 4 		 4

Вторая часть хорошего воспроизводимого примера – это пример кода. При-
мер кода должен быть максимально простым и  иллюстрировать то, что вы 
пытаетесь сделать или уже пробовали сделать. Это не  должен быть большой 
блок кода со множеством разных вещей. Сделайте так, чтобы пример содер-
жал минимальное количество необходимого кода. Если вы используете какие-
либо пакеты, обязательно включите вызов library в начале своего кода. Кроме 
того, не включайте в свой вопрос ничего, что могло бы нанести вред человеку, 
выполняющему ваш код, например rm(list = ls()), что могло бы удалить все 
объекты R в памяти. Имейте сочувствие к человеку, пытающемуся помочь вам, 
и поймите, что он добровольно жертвует свое время, чтобы помочь вам, и мо-
жет выполнять ваш код на той же машине, которую использует для выполнения 
своей работы.

Чтобы проверить свой пример, откройте новый сеанс R и попробуйте запус
тить его. После того как вы отредактировали свой код, пришло время дать не-
много больше информации потенциальным респондентам. В текстовом виде 
опишите, что вы пытаетесь сделать, что пытались сделать и свой вопрос. Будьте 
максимально лаконичны. Как и в примере кода, ваша цель – максимально эф-
фективно общаться с человеком, читающим ваш вопрос. Может быть полезно 
указать в своем описании, какую версию R вы используете и какую платформу 
(Windows, Mac, Linux). Эту информацию можно легко получить с помощью ко-
манды sessionInfo.

Если вы собираетесь отправить свой вопрос в список рассылки R, вы долж-
ны знать, что на самом деле существует несколько таких списков. R-help – это 
основной список для общих вопросов. Существует также множество списков 
рассылки специальных групп интересов (SIG), посвященных конкретным об-
ластям, таким как генетика, финансы, разработка на языке R и даже вакансии 
для разработчиков. Полный список можно увидеть на странице https://stat.ethz.
ch/mailman/listinfo. Если ваш вопрос относится к какой-то области, вы полу-
чите более подходящий ответ, выбрав соответствующий список. Однако, как 
и  в  случае с  R-help, внимательно выполняйте поиск в  архивах списков SIG, 
прежде чем задавать свой вопрос.
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См. также
Мы предлагаем вам прочитать превосходное эссе Эрика Рэймонда и Рика Моена 
под названием «Как правильно задавать вопросы» (http://www.catb.org/~esr/faqs/
smart-questions.html), перед тем как отправлять какие-либо вопросы. Серьезно. 
Прочтите его.

На сайте Stack Overflow есть отличный пост, в котором содержатся подробные 
сведения о создании воспроизводимого примера. Его можно найти на странице 
https://stackoverflow.com/q/5963269/37751. 

У Дженни Брайан есть замечательный пакет под названием reprex, который 
помогает создать хороший воспроизводимый пример и предоставляет вспомо-
гательные функции для написания текста на языке разметки Markdown для та-
ких сайтов, как Stack Overflow. Этот пакет можно найти на ее странице в GitHub 
(https://github.com/tidyverse/reprex).
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